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CAUTIONS 

- This document applies only to the product(s) identified herein. 

 

- No part of this document may be reproduced, stored in a retrieval system, or 

transmitted in any form or by any means, electronic, mechanical, photocopying, 

recording, or otherwise, without the prior written permission of SEIKO EPSON CORPORATION. 

 

- The contents of this document are subject to change without notice. Please contact 

EPSON for the latest information. 

 

- While every precaution has been taken in the preparation of this document, SEIKO 

EPSON CORPORATION assumes no responsibility for errors or omissions. 

 

- Neither is any liability assumed for damages resulting from the use of the Information contained herein. 

 

- Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or  

third parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of 

accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this  

product, or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION.s operating  

and maintenance instructions. 

 

- SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any  

options or any consumable products other than those designated as Original EPSON Products or EPSON  

Approved Products by SEIKO EPSON CORPORATION. 

 

TRADEMARKS 

EPSON is a registered trademark of SEIKO EPSON CORPORATION. 

General Notice: Other product and company namFes used herein are for identification 

purposes only and may be trademarks of their respective companies. 

 

Microsoft, Windows, Windows Vista, and Windows7 are registered trademarks of Microsoft Corporation in the 

US and other countries. 

 

Copyright(C) SEIKO EPSON CORPORATION 2007-2009. All rights reserved. 
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1. Features 
This tool is for updating the firmware of TM series, SIDM series and Business IJ series. 

The tool allows you to update firmware simply, safely, and quickly. 

 

1) The tool allows you to update firmware easily using a USB, parallel, serial, or Ethernet interface. 

 

2) The tool supports rewriting without device operation, (not requiring manual operation of the device to be 

updated). 

- Manual operation of the control panel of the device is not required. (Excluding certain models) 

- With devices that can print, checking the version with self-test printing after updating is not required. 

 

3) Even if you specify the file for a different model, the tool checks the model automatically, so there is no need 

to worry that you will harm the device.  

 

4) Using the tool with models that support high-speed communication allows you to update firmware 2-4 times 

faster over a USB or parallel interface, and about 25 times faster over a serial interface (with an SIDM 

printer). 

 

5) With USB and Ethernet interfaces, you can update the firmware of multiple devices at the same time. 

 

2. Tool Specification/Operating Environment 
Refer to the [3.Tool Specification / 4.Operating Environment ] of the ReadMe for detailed information. 

 

3. Supported Models 
Refer to the [5. support models] of the ReadMe for detailed information. 



 

4. Installation and Uninstallation 
Installation: Create a folder in a suitable location on your PC, and copy the following files into the same folder. (No 

other installation procedure is required.) 

 FlashWriter.exe (This tool) 

 The firmware file required for the update 

* In Windows Vista®, and Windows® 7, copy the files to a location other than the system drive root. 

 

Uninstallation: Delete the following files from the folder containing FlashWriter.exe. 

 FlashWriter.exe (This tool) 

 FlashWriter.csv (History file) 

 FlashWriter.ini (Setting file) 

 The firmware file used for the update 

 

5. Explanation of the User Interface 
The following section explains the user interface of the tool. 

 

5.1 Names of each part 
1) Tool Bar 

The bar (Figure 1) below the menu is called the Tool Bar. 

The Tool Bar is for switching between operation windows and for displaying the history and version information. 

 

 
    

Figure 1 Tool Bar 

 

Explanation of the icons 

(1) From the left, the icons switch to the File Setting Window, Communication Setting Window, and Update 

Window.  

(2) From the left, the icons switch to the History Window, and display the Version Information Dialog Box. 
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2) Setting content display window 

In the left window (Figure 2), the Update File Information is displayed when the firmware file is specified, the 

Communication Setting Information is displayed when the communication settings are made, and the Device 

Information is displayed when the communication test is performed. 

The content displayed is as follows. 
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The content displayed in the Communication Setting 
Information differs according to the communication 
interface. 

  1) Serial interface 
 Communication port number / 

 Communication speed (baud rate) / 
      Parity type / Negotiation (Baud Rate Up)  
  2) Parallel interface 

 Communication port number 
  3) USB interface 

 Hub port number /  
Communication port number 

  4) Ethernet interface 
 IP address 

Device Information 

 Model name acquired from the device 

 Version acquired from the device 

 Other device information (TM Series only) 

 File version 

 Model name 

Update File Information 

 

 

 

Figure 2 Information Display Window 
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6. Operating Procedure 
The tool can be used in the following ways. 

1) Normal update mode 

2) USB / Ethernet multiple simultaneous update mode 

This section explains the operating procedures for each mode. 

 

Note:  

The operating procedures shown below assume that the device is running normally. 

 

6.1 Normal update mode operating procedure 
For normal update, use the General Update Mode. 

The overall procedure is as follows. 

1) Preparation 

2) Start the tool 

3) Set the firmware file to write to the device 

4) Make the communication settings for the interface 

5) Update the firmware 

 

6.1.1 Preparation 

1) Log in to the PC with administrator privileges. 

* In Windows Vista®, and Windows® 7 authorize firmware update as the administrator. 

 

2) Check that the device is running normally. 

 

3) To update the firmware using a serial interface, refer to “5. Settings for Supported Models,” and change 

the serial settings of the device as necessary. 

 



 

6.1.2 Start the tool 

Double click the FlashWriter.exe icon in the installation folder to start the tool. 

 

Note:  

* When the tool is started up initially, it detects the language of the OS, and switches the display between 

English and Japanese. 

If the OS is English the tool displays English, and if the OS is Japanese the tool displays Japanese at 

startup.  

Thereafter it starts up with the language set when you last quit the tool. 

 

* The tool saves the settings at shutdown in the setting file (FlashWriter.ini). 

In the following cases, delete the setting file before starting up. 

 If you run the tool in a Japanese OS, move the folder of the tool to an English OS  

(If you start the tool with the Japanese settings, garbled characters are displayed) 

 If you want to return to the status at initial startup 

 

6.1.3 Set the firmware file to write to the device 

When you start up the tool, the File Setting Window (Figure 3) is displayed. 

 

3 

2 1

Figure 3 File Setting Window 
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1) Click “Open Firmware Files” to call up the file selection dialog box and select the device update firmware 

file. 

When you specify a file, the file name, model name and file version are displayed in the Setting Content 

Display Window on the left, and the file name, size and last update time of the selected file are 

displayed in the Operation Window on the right. 

 

2) If you unintentionally specify an unnecessary file, delete it. Click the file to delete in the Operation 

Window on the right, and click “Delete.” 

 

3) When you have set the update file, click the Communication Setting Window icon on the Tool Bar, which 

is now enabled. The Communication Setting Window opens. Proceed to the items in “9.1.4 Make the 

communication settings for the interface.” 

 

6.1.4 Make the communication settings for the interface 

Click the Communication Setting Window icon to move to the window shown in Figure 4. 

Make the communication settings for the interface of the connected device. 

 

Figure 4 Communication Setting Window 

 

* If you select “Model filter,” only the models relevant to the specified firmware file are displayed. 
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6.1.4.1 When the device is connected via a serial interface 

The settings for a serial interface are made in the window shown in Figure 5. 

 

 

1 

2 

3

4

6

7 

5

Figure 5 Serial Communication Setting Window 

 

1) Click “COM.” 

 

2) From the communication port field in the Operation Window, select the COM port to which the device 

is connected. 

           

3) From the “Baud Rate” combo box, select a speed setting that matches the baud rate of the device to 

be updated. 

 

4) From the “Parity” combo box, select a parity setting that matches the parity of the device to be 

updated. 

 

5) Check that the “Baud Rate Up” checkbox is selected. (*1) 

  Selecting this item allows models that support high-speed communication to complete the update 

faster. 
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6) Click “Communication Test” and check that the message “The communication test was successful.” is 

displayed. 

 If the “The communication test failed. (Omitted)” message is displayed, click “OK” to close the 

message, and check whether the settings in 1)-5) above are correct for the device. If the message 

continues to be displayed, turn the device off and on again, make all the settings again and click 

“Communication Test.” 

 If an SIDM printer or the TM series is running in the Program Reload mode or Memory Rewriting 

mode (*2), the communication test cannot be performed. 

 

7) If the message “The communication test was successful.” is displayed, click “OK” to close the 

message. 

Click the Update Window icon on the Tool Bar, which is now enabled. 

The Update Window opens. Proceed to the items in “9.1.5 Updating the firmware.” 

 

8) If the device is running normally, you can also check whether the correct port is selected for the 

device by clicking “Print Test.” 

 (Only for models with a self-test function.) 

 Click “Print Test” and if the device prints “EPSON FlashWriter Test Print” the correct port is selected. 

 If an SIDM printer or the TM series is running in the Program Reload mode or Memory Rewriting 

mode, this test method cannot be used. Continue without clicking “Print Test.” 

 

(*1) The high-speed communication function performs negotiation between the tool and the device when 

updating the firmware file, so that updating can be performed at the maximum communication 

speed of the device, instead of the communication speed (baud rate) set in the device.  

When the function is on, the tool automatically sets models that support high-speed communication 

to the maximum communication speed of the device.  

If it is not supported, the tool updates the device at the currently set communication speed. 

When the function is off, even if high-speed communication is supported, the tool updates the 

device at the currently set communication speed. 

Under normal circumstances, turn the function on (selected). 

 

(*2) The Memory Rewriting mode is a special firmware rewriting mode initiated by turning on the device 

while operating Dip-switch. (TM series only) 



 

6.1.4.2 When the device is connected via a parallel interface 

The settings for a parallel interface are made in the window shown in Figure 6. 

 

 

4 

1

2 

3

Figure 6 Parallel Communication Setting Window 

 

1) Click “LPT.” 

 

2) From the communication port field in the Operation Window, select the LPT port to which the device is 

connected. 

 

3)-5) Refer to 6)-8) in “9.1.4.1 When the device is connected via a serial interface.” 
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6.1.4.3 When the device is connected via a USB interface 

The settings for a USB interface are made in the window shown in Figure 7. 

 

 

5 

3 1

2 

4

Figure 7 USB Communication Setting Window 

 

1) Click “USB.” 

 

2) From the communication port field in the Operation Window, select the USB port to which the device 

is connected. 

 

3) If the USB port is not displayed, click “Search port.” 

This detects the port of the connected device. 

 

4)-6) Refer to 6)-8) in “9.1.4.1 When the device is connected via a serial interface.” 
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6.1.4.4 When the device is connected via an Ethernet interface 

The settings for an Ethernet interface are made in the window shown in Figure 8. 

 

 

1

2 

3 

4

5 

Figure 8 Ethernet Communication Setting Window 

 

1) Click “NET.” 

 

2) From the communication port field in the Operation Window, select the IP address for the connected 

device. (*1) 

 

3) If the IP address is not displayed, click “Search port.” 

This detects the IP address of the connected device. 

 You can also directly enter the IP address of the device to be updated. 

Enter the IP address in “Add Port” and click “Add.” 

If the IP address entered is correct, the IP address is displayed in the communication port field. 

 

4)-6) Refer to 6)-8) in “9.1.4.1 When the device is connected via a serial interface.” 

 

(*1) It takes several seconds before the IP address is displayed after you click “NET.” 
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6.1.5 Updating the firmware 

Click the Update Window icon to move to the window shown in Figure 9. 

 

 

1 

2

Figure 9 Firmware Update Window 

 

1) Reconfirm the settings for model name, communication port and file name displayed in the Operation 

Window. 

 

2) When you have checked each setting, click “Execute Firmware Update.” 

The firmware is updated. 

The Progress Bar shows how much of the task you have completed. 

 

Warning: 

*1 Do NOT turn off the device during the update. Doing so will cause the firmware update to fail. 

*2 Do not let the host PC enter the power save mode (standby or sleep). Doing so will cause the 

firmware update to fail. 
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3) If the update finishes normally, the message “Firmware was successfully updated.” is displayed. Click 

“OK” to close the message. 

 

4) When file update is completed, click “Communication Test,” and check the version to ensure that the 

firmware has been updated correctly. 

 

5) In the “File” menu select “Exit” to exit the tool. 

 



 

6.2 Operating procedure for the USB / Ethernet Multiple Simultaneous Update mode 
To update multiple devices at the same time using a USB or Ethernet interface, use the Multiple Simultaneous 

Update mode. The overall procedure is as follows. (A USB interface is used here for explaining the procedure.) 

1) Preparation 

2) Start the tool 

3) Switch the mode 

4) Set the firmware file to write to the device 

5) Make the communication settings for the interface 

6) Update the firmware 

 

6.2.1 Preparation 

1) Log in to the PC with administrator privileges. 

* In Windows Vista® , and Windows® 7 authorize firmware update as the administrator. 

 

2) Check that each device is running normally. 

 

3) As an example, connect a 4-port USB hub to the host PC. 

 

4) Connect the same model of device to the USB hub as shown in Figure 10. 

 The USB hub port number and the device connected to it must correspond; therefore we recommend 

that you assign a USB hub port number to each device and cable.  

 You cannot update different models at the same time.  

 18/39 

©SEIKO EPSON CORPORATION 2007-2009. All rights reserved. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 10 Example of Printer and USB Hub Connection  

3

4

Disconnect completed 
printers and replace with new 

printers to update 

USB Hub

1 
 2

  
3 

 4
 

2

This port number and printer correspond  HUB1-Port3 
 HUB1-Port4 

 HUB1-Port2 
 HUB1-Port1 

The tool recognizes 

printers by the 

location of the port 

number of the hub to 

which they are 

connected 

1



 

6.2.2 Start the tool 

Refer to the normal update mode operating procedure 

 

6.2.3 Switch the mode 

In the “View” menu select “Update Mode” and select “Multiple Simultaneous Update Mode.” 

 

6.2.4 Set the firmware file to write to the device 

Refer to the normal update mode operating procedure 

 

6.2.5 USB Interface communication settings 

After switching to the Update Window, 

1) Click “USB.” 

Clicking the button moves to the window shown in Figure 11. 

 

 

5 

3 1

2 

4

Figure 11 USB Interface (USB Multiple Simultaneous Update) 
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2) Select devices to update by selecting the checkboxes to the left of the USB ports. 

 

3) If the USB port is not displayed, click “Search port.” 

This detects the port of the connected device. 

Also if you have changed the port to which a device is connected, click “Search port.” 

 

4) Click “Communication Test” and check that the device version has been acquired in the version field of 

the Operation Window. 

 If the version has not been acquired and “×” is displayed on the USB icon in the Operation Window, 

check whether the settings in 1)-3) above are correct for the device. 

If the message continues to be displayed, turn the device off and on again, make all the settings again 

and click “Communication Test.” 

 If an SIDM printer or the TM series is running in the Program Reload mode or Memory Rewriting 

mode, the communication test cannot be performed. 

 

5) When you have confirmed that the version in 4) above is displayed, click the Update Window icon 

in the Toolbar. The Update Window opens. Proceed to the items in “9.2.6 Updating the firmware.” 

 

6) If the device is running normally, you can also check whether the correct port is selected for the device 

by clicking “Print Test.” 

(Only for models with a self-test function.) 

 Click “Print Test” and if the device prints “EPSON FlashWriter Test Print” the correct port is selected. 

 If an SIDM printer or the TM series is running in the Program Reload mode or Memory Rewriting 

mode, this test method cannot be used. Continue without clicking “Print Test.” 

 

* Do not uncheck “Model filter.” 

 



 

6.2.6 Updating the firmware 

Click the Update Window icon to move to the window shown in Figure 12. 

 

 

1 

2

3 

4 

Figure 12 Firmware Update Window (USB Multiple Simultaneous Update) 

 

1) Reconfirm the settings for communication port, model name and file name displayed in the Operation 

Window. 

 

2) When you have checked each setting, click “Execute Firmware Update.” 

The firmware is updated. 

The progress of each device is displayed in “Status” and “Progress.” 

The Progress Bar shows the progress of the task overall. 

 

Warning: 

*1 Do NOT turn off the devices during update. Doing so will cause the firmware update to fail. 

*2 Do not let the host PC enter the power save mode (standby or sleep). Doing so will cause the 

firmware update to fail. 

 21/39 

©SEIKO EPSON CORPORATION 2007-2009. All rights reserved. 
 



 22/39 

©SEIKO EPSON CORPORATION 2007-2009. All rights reserved. 
 

 

3) If the update of all the devices finishes normally, the message “Firmware was successfully updated.” is 

displayed. Click “OK” to close the message. 

For devices that are updated normally, a “” icon is displayed to the left of the communication port. 

 

4) When file update is completed, click “Communication Test,” and check the version to ensure that the 

firmware has been updated correctly. 

 

5) In the “File” menu select “Exit” to exit the tool. 

 

* With a USB interface 10 printers can be updated, and with an Ethernet interface 128 printers can be 

updated at the same time. 

 



 

7. History Window 
Clicking the History icon on the Tool Bar displays the History Window (Figure 13). 

When update is completed, you can check the content of updates on this window. 

 

Figure 13 History Display Window 

The following content is displayed in the History Window. 

Item Item 

Execution time and date The date and time that firmware was updated 

Total Time The total time taken for updating the firmware 

Port Information The communication setting information displayed in the Setting Content 

Display Window 

Error code Error codes for the results of updates 

Error message Error messages displayed when updates finish 

File name The specified file name 

File version The version of the update file displayed in the Setting Content Display 

Window 

Model name The model name of the update file displayed in the Setting Content Display 

Window 

Version The version information acquired from the devices when updates finish 

Serial Number Serial Number of a device (Only TM series) 
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8. Cautions 
1) Quit other applications before running the tool. 

2) Check that communication with the devices is possible before running the tool (Printers: Printing is possible). 

3) Do not force quit when the tool is running. 

4) Do not turn off devices when the tool is running. 

5) Do not disconnect interface cables when the tool is running. 

6) Do not let the host PC enter the power save mode (standby or sleep) when the tool is running. 

7) When the tool is running, the print spooler is stopped, so printers cannot print when the firmware is being 

updated. 

8) The tool does not permit another installation of the tool to run at the same time, so you cannot update multiple 

devices by running multiple installations of the tool. 

9) The tool prevents TMFlashWriter.exe and SIDMFlash.exe from running at the same time. 

10) When using the tool, logon as a user with administrator privileges. 

11) When using the tool in Windows Vista®, and Windows® 7, authorize firmware update as the administrator. 

If you do not authorize firmware update as the administrator, the tool may not start up or may not start up 

normally. 

12) When using the tool in Windows Vista® , and Windows® 7 and if the DPI setting is set to more than 120%, 

part of the window may not be displayed properly.(*1)  

13) When using a serial interface, set the serial settings of the device to Data length = 8 bits and Stop bits = one 

stop bit. 

We recommend setting the serial settings of other devices to Baud rate = 9,600 bps and Parity = None. 

14) If “Failed to confirm the printer version after updating.” is displayed, turn the device off and on again, and using 

self-test printing or “Communication Test” or “Confirm,” check that the version of the device is the expected 

one. 

If the result is one of the following, turn the device off and on again, and update the firmware again. 

- The version of the device is not the expected one 

- The device cannot perform self-test printing (models with a self-test function) 

- The version of the device is “00000000” 

15) If PLQ-20D/PLQ-20DM are started with operation of the panel buttons in the Program Reload mode, use the 

serial settings Baud rate = 9,600 bps and Parity = None. 

If main firmware update fails, and the devices are running in Update mode, use the serial settings Baud rate = 

9,600 bps and Parity = None. 



 

16) To update the firmware of an SIDM printer from the Program Reload mode, use a parallel or USB interface. 

When you click “Execute Firmware Update,” the following message is displayed. Click “Yes.” 

 

However, in this case, reconfirm that the firmware for updating is the correct one for the printer to be updated. 

Updating the printer with a wrong firmware file may damage the printer. 

 

17) When updating firmware, it is very occasionally necessary to update the boot area. 

When updating the boot area, and if the update fails, the printer cannot be restarted and there is no means of 

repairing it. Therefore you should strictly control the environment, and carry out updating with great care. 

When updating the boot area, use a parallel or USB interface. Do NOT use any other interface (especially a 

serial interface). 

 

  18) When you use a wireless print adapter (EpsonNet 802.11b/g Wireless and 10/100BaseTx External Print 

Server), please change [Get IP Address] of a TCP/IP setting into [Manual]. 

      When a setup is [Auto], it cannot update normally. 

      As for a wireless print adapter, main part firmware should use the thing after a version 1.20. 

      When the version of firmware is older than 1.20, it cannot update normally. 

 

(*1) Set the display resolution to the maximum. 
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9 Acknowledgements 
  "FlashWriter" incorporates compression code from the Info-ZIP group. 

------------------------------------------------------------------------------------------- 

This is version 2007-Mar-4 of the Info-ZIP license. 

The definitive version of this document should be available at 

ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely and 

a copy at http://www.info-zip.org/pub/infozip/license.html. 

 

 

Copyright (c) 1990-2007 Info-ZIP.  All rights reserved. 

 

For the purposes of this copyright and license, "Info-ZIP" is defined as 

the following set of individuals: 

 

   Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, 

   Jean-loup Gailly, Hunter Goatley, Ed Gordon, Ian Gorman, Chris Herborth, 

   Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, Paul Kienitz, 

   David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, 

   Steve P. Miller, Sergio Monesi, Keith Owens, George Petrov, Greg Roelofs, 

   Kai Uwe Rommel, Steve Salisbury, Dave Smith, Steven M. Schweda, 

   Christian Spieler, Cosmin Truta, Antoine Verheijen, Paul von Behren, 

   Rich Wales, Mike White. 

 

This software is provided "as is," without warranty of any kind, express 

or implied.  In no event shall Info-ZIP or its contributors be held liable 

for any direct, indirect, incidental, special or consequential damages 

arising out of the use of or inability to use this software. 

 

Permission is granted to anyone to use this software for any purpose, 

including commercial applications, and to alter it and redistribute it 

freely, subject to the above disclaimer and the following restrictions: 
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     1. Redistributions of source code (in whole or in part) must retain 

       the above copyright notice, definition, disclaimer, and this list 

       of conditions. 

 

     2. Redistributions in binary form (compiled executables and libraries) 

       must reproduce the above copyright notice, definition, disclaimer, 

       and this list of conditions in documentation and/or other materials 

       provided with the distribution.  The sole exception to this condition 

       is redistribution of a standard UnZipSFX binary (including SFXWiz) as 

       part of a self-extracting archive; that is permitted without inclusion 

       of this license, as long as the normal SFX banner has not been removed 

       from the binary or disabled. 

 

     3. Altered versions--including, but not limited to, ports to new operating 

       systems, existing ports with new graphical interfaces, versions with 

       modified or added functionality, and dynamic, shared, or static library 

       versions not from Info-ZIP--must be plainly marked as such and must not 

       be misrepresented as being the original source or, if binaries, 

       compiled from the original source.  Such altered versions also must not 

       be misrepresented as being Info-ZIP releases--including, but not 

       limited to, labeling of the altered versions with the names "Info-ZIP" 

       (or any variation thereof, including, but not limited to, different 

       capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without the 

       explicit permission of Info-ZIP.  Such altered versions are further 

       prohibited from misrepresentative use of the Zip-Bugs or Info-ZIP 

       e-mail addresses or the Info-ZIP URL(s), such as to imply Info-ZIP 

       will provide support for the altered versions. 

 

     4. Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," 

       "UnZipSFX," "WiZ," "Pocket UnZip," "Pocket Zip," and "MacZip" for its 

       own source and binary releases. 
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Appendix 1 (Debug Mode) 
The tool has a Debug Mode. 

The Debug Mode of the SIDM series shown below is not supported. Users use it at their own risk. 

 

1. Updating with RCC format firmware files 
If you cannot use an EFU format firmware file for some reason, it is possible to perform update with an RCC 

format firmware file by changing the filter extension of “File Type” to “rcc files” in the file selection dialog box. 

However, in this case, if you update a different model or a device with a different board configuration, you may 

harm the device; therefore, care is required.  

 

2. Updating a model that does not support high-speed communication using a serial 

interface 
When updating models that do not support high-speed communication, and if you cannot use a parallel, USB, 

or Ethernet interface for some reason, you can use a serial interface with the following method. 

However, in this case, it takes about 90 minutes to complete the update. 

If you update a different model or a device with a different board configuration, you may harm the device, 

therefore care is required.  

 

1) Specify the firmware file of a model that does not support the serial interface. 

 

2) In the Communication Setting Window click “COM,” and select the communication port to which the device 

is connected. 

 

3) The Execute Firmware Update Window is displayed. Click “Execute Firmware Update.” 

 

4) The message “It takes about 90 minutes for the update. Are you sure you want to execute this?” is 

displayed. Click “Yes.” 

 

5) If the device is running in the Program Reload mode, the following message is displayed. Click “Yes.” 



 

 

 

6) File transmission starts. 

 

3. Updating a model with the firmware for a different target language 
It may be possible to update a model of the same type and with the same board configuration with firmware for 

a different language. 

However, in this case, if you update a different model or a device with a different board configuration, you may 

harm the device, therefore care is required.  

 

1) Specify a firmware file of the same model as the device to be updated. 

 

2) Make the communication settings, and select the communication port to which the device is connected. 

 

3) If the device is not displayed, remove the check from “Model filter” and click “Search port.” 

Note:  

If you select the wrong device, you may harm the device. 

Be sure to select the correct device. 

 

4) The Execute Firmware Update Window is displayed. Click “Execute Firmware Update.” 

 

5) The same message as shown in 5) in “2. Updating a model that does not support high-speed 

communication using a serial interface” is displayed. Click “Yes.” 

 

6) File transmission starts. 
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4. Updating in the Program Reload mode  
When updating an SIDM printer in the Program Reload mode, the printer name may not be displayed if you use 

a USB interface. 

If the printer name is not displayed, remove the check from “Model filter” and click “Search port.” 

If the printer name is still not displayed after clicking “Search port,” update the firmware using an interface other 

than the USB interface. 

 



 

Appendix 2 
1. Wizard format 

The tool also has a Wizard format for updating firmware. 

Following the Wizard, you can easily perform the tasks from file settings to executing the update. If the user will 

use the Wizard, it is convenient to set the Wizard format in advance. 

 

The procedure up to updating is as follows. 

 

1) Open the FlashWriter.ini setting file. 

 

2) Change the “WizardMode=0” item from “0” to “1.”  

 

3) Save FlashWriter.ini. 

 

4) Start up FlashWriter.exe. 

 

5) The following window is displayed. 
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6) Specify a file. 

When you specify a file, “Next” is enabled. Click “Next.” 

To cancel the operation, click “Cancel.” 

 

 

7) Select the interface of the connected device. 
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8) Specify the interface and click “Communication Test.” 

If the communication test is successful, “Next” is enabled. Click “Next.” 

To change the file, click “Back” to return the Specify File Window. 

 

 

9) Check the specified “Port Name” and “File Name” and click “Start” to start the update. 
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10) When update finishes normally, the following window is displayed. 

 
Click “Finish.” 
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Appendix 3 
1. Self-extracting automatic execution format (Windows®2000 or later) 

The tool can also update firmware with self-extracting executable format files. 

This consists of a preset update firmware file and communication settings, packaged in a single executable file 

format. 

The user need not worry about the file or communication settings, and can update the firmware simply by 

clicking “Execute Firmware Update.” 

In addition, since there is only one file, it is easy to distribute to users. 

 

The procedure for creating the file is as follows. 

 

1) Put FlashWriter.exe and the firmware file to be updated in the same folder. 

 

2) Start up FlashWriter.exe. 

 

3) Specify the firmware file in the same folder. 

 

4) Select the interface in the Communication Settings Window. 

 

5) Move to the Execute Update Window and in the “View” menu, select “Display Update Window Only.” 

 

6) Quit FlashWriter.exe without further changes. 

 

7) Open the FlashWriter.ini setting file. 

 

8) Change the “WizardMode=0” item from “0” to “1.”  

 

9) Save FlashWriter.ini. 

 

10) Open the Windows® “Start” menu. 

 

11) In the “Start” menu, select “Run.” 

 

12) Enter “iexpress.” 



 

13) The following window is displayed. 14) Click “Next.”  

         

Click “Next” without any settings. 

 

 

15) Enter a title of the package.                 16) Click “Next.” 

Here, “SIDM” is entered as an example. 

         

Click “Next.” 
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17) Click “Next” without any settings.           18) Click “Add,” and add FlashWriter.exe, 

FlashWriter.ini and the firmware file that are in the 

FlashWriter.exe folder. 

         

                                                     After adding the 3 items, click “Next.” 

 

 

19) In “Install Program,” specify “FlashWriter.exe.” 20) Select “Hidden.” 

 

         

After specifying “FlashWriter.exe," click “Next.” After selecting, click “Next.” 
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21) Click “Next” without any settings.           22) Click “Browse,” select the target path, and enter a 

name of the executable file. 

In this example, the target path is “C:¥” and the 

executable file package is 

“FlashWriter_Auto.exe.” 

Select the 2 options below. 

         

Check the content entered and click “Next.” 

 

 

23) Select “No restart” (“No reboot” in some OS’s). 24) Click “Next.” 

 

         

After selecting, click “Next.” 
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25) Click “Next” without any settings.           26) When the package is completed, the window  

The package is created. above is displayed. 

 

         

Click “Finish” to complete. 

 

 

27) Check that the executable format file has been     28) If the following icon is displayed, the  

created correctly. package has been created successfully. 

Run the executable file. The file can be distributed. 
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